Section 3:

Prokaryotic Sample and Array Processing
Contents

Section 3 Prokaryotic Sample and Array Processing

Chapter 1 Prokaryotic Target Preparation 3.1.3

Chapter 2 Prokaryotic Target Hybridization 3.2.3

Chapter 3 Prokaryotic Arrays: Washing, Staining, and Scanning 3.3.3
Section 3, Chapter 1
This chapter contains:

This chapter describes the assay procedures recommended for use with the GeneChip® P. aeruginosa Genome Array and the GeneChip® E. coli Antisense Genome Array. The assay utilizes reverse transcriptase and random hexamer primers to produce DNA complementary to the RNA. The cDNA products are then fragmented by DNase I and labeled with terminal transferase and biotinylated GeneChip® DNA Labeling Reagent at the 3’ termini.

This protocol is presented as a recommendation only, and has not been validated by Affymetrix.
Target Labeling for Prokaryotic GeneChip® Antisense Arrays

1. RNA Extraction
2. Random priming cDNA synthesis
3. RNA degradation with NaOH
4. cDNA column purification
5. cDNA fragmentation and terminal labeling with biotinylated GeneChip® DNA Labeling Reagent

Legend: RNA DNA Biotin
Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and evaluated by Affymetrix scientists. Information and part numbers listed are based on U.S. catalog information. For supplier information, please refer to the Supplier Reference List in Appendix A of this manual.

Labeling
- dNTP, Invitrogen Life Technologies, P/N 18427-013
- Random Primers, 3 µg/µL, Invitrogen Life Technologies, P/N 48190-011
- GeneChip® Eukaryotic Poly-A RNA Control Kit, Affymetrix, P/N 900433
- SuperScript II™ Reverse Transcriptase, Invitrogen Life Technologies, P/N 18064-071
- SUPERase•In™, Ambion, P/N 2696
- Nuclease-free Water, Ambion, P/N 9930
- NaOH, 1N solution, VWR Scientific Products, P/N MK469360
- HCl, 1N solution, VWR Scientific Products, P/N MK638860
- MinElute PCR Purification Kit, QIAGEN, P/N 28004
- GeneChip® DNA Labeling Reagent, Affymetrix, P/N 900542
- Terminal Deoxynucleotidyl Transferase, Promega, P/N M1875
- EDTA, 0.5M, pH 8.0, Invitrogen Life Technologies, P/N 15575-020
- Non-stick RNase-free microfuge tubes, 0.5 mL and 1.5 mL, Ambion, P/N 12350 and P/N 12450, respectively

Gel-Shift Assay
- Novex XCell SureLock™ Mini-Cell, Invitrogen Life Technologies, P/N EI0001
- 4-20% TBE Gel, 1.0 mm, 12 well, Invitrogen Life Technologies, P/N EC62252
- Sucrose Gel Loading Dye, 5X, Amresco, P/N E-274
- 10X TBE Running Buffer
- SYBR Gold, Molecular Probes, P/N S-11494
- 10 bp and 100 bp DNA ladder, Invitrogen Life Technologies, P/N 10821-015 and 15628-019, respectively
- ImmunoPure NeutrAvidin, Pierce Chemical, P/N 31000
- 1M Tris, pH 7.0, Ambion, P/N 9850G
- PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027
Reagent Preparation

75 ng/µL Random Primers

For 1000 µL:

25 µL of 3 µg/µL Random Primers
975 µL of Nuclease-free H₂O

Store at -20°C in a non-frost-free freezer.

2 mg/mL NeutrAvidin

Resuspend 10 mg NeutrAvidin in 5 mL PBS solution. Store at 4°C.
Total RNA Isolation

As starting material for the cDNA synthesis procedure, total RNA can be isolated by using standard procedures for bacterial RNA isolation or various commercial RNA isolation kits.

For *Pseudomonas aeruginosa* and *E. coli*, we have successfully used the QIAGEN® RNeasy Mini Purification Kit. Caution should be used to minimize chromosomal DNA contamination during the isolation, due to the high sensitivity of the assay. It is suggested that no more than $1 \times 10^9$ cells are applied to a single purification column. Also, use the lysozyme at a concentration of 1 mg/mL, and not the recommended 400 µg/mL. Additional DNase I treatment may be required to eliminate DNA contamination when the bacterial culture is grown at high density.

After purification, RNA concentration is determined by absorbance at 260 nm on a spectrophotometer (1 absorbance unit = 40 µg/mL RNA). The $A_{260}/A_{280}$ ratio should be approximately 2.0, with ranges between 1.8 to 2.1 considered acceptable. We recommend checking the quality of RNA by running it on an agarose gel prior to starting the assay. The 23S and 16S rRNA bands should be clear without any obvious smears. Any indication of the presence of chromosomal DNA contamination (high molecular weight bands or smears on the gel) would require additional DNase treatment before proceeding to cDNA synthesis.

![Figure 3.1.1](image_url)

Lane 1 - 1 µg Sample 1  
Lane 2 - 1 µg Sample 2  
Lane 3 - 1 µg Sample 3  
Lane 4 - RNA Size Markers

*Figure 3.1.1*  
Typical RNA preparation from *E. coli*
cDNA Synthesis

The following protocol starts with 10 µg of total RNA. Incubations are performed in a thermal cycler.

**Note**

The integrity of total RNA is essential for the success of the assay. Exercise precautions and follow standard laboratory procedures when handling RNA samples.

**Step 1: Preparation of Poly-A RNA Controls**

The Poly-A RNA Control Stock and Poly-A Control Dil Buffer are provided with the Poly-A RNA Control Kit (P/N 900433) to prepare the appropriate serial dilutions based on the following recommendation:

**Table 3.1.1**  
Serial Dilutions of Poly-A RNA Control Stock

<table>
<thead>
<tr>
<th>Array Format*</th>
<th>Serial Dilutions</th>
<th>Spike-in Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>First</td>
<td>Second</td>
</tr>
<tr>
<td>169 Format (Mini)</td>
<td>1:20</td>
<td>1:16</td>
</tr>
<tr>
<td>100 Format (Midi)</td>
<td>1:20</td>
<td>1:20</td>
</tr>
<tr>
<td>49 Format (Standard)</td>
<td>1:20</td>
<td>1:13</td>
</tr>
</tbody>
</table>

*Please refer to specific probe array package insert for information on array format.

Avoid pipetting solutions less than 2 µL in volume to maintain precision and consistency when preparing the dilutions.

The Poly-A RNA Control Stock contains in vitro synthesized, polyadenylated transcripts for B. subtilis genes that are pre-mixed at staggered concentrations. The concentrations of the spikes in the stock solution are: lys 7.6 nM, phe 15.2 nM, thr 30.4 nM, and dap 114.0 nM. Following the recommended dilutions as shown above, the final concentrations of the spikes in the hybridization cocktail (Table 3.2.1) are lys 0.256 pM, phe 0.511 pM, thr 1.022 pM, and dap 3.833 pM.

We strongly recommend using control transcripts to monitor the assay sensitivity and performance. Probe sets for these control genes from B. subtilis have been tiled on the GeneChip® P. aeruginosa Genome Array and E. coli Antisense Genome Array.

For example, to prepare the poly-A RNA dilutions for a 100 format array:

**IMPORTANT**

Use non-stick RNase-free microfuge tubes to prepare all of the dilutions.

1. Add 2 µL of the Poly-A RNA Control Stock to 38 µL of Poly-A Control Dil Buffer for the First Dilution (1:20).
2. Mix thoroughly and spin down to collect the liquid at the bottom of the tube.
3. Add 2 µL of the First Dilution to 38 µL of Poly-A Control Dil Buffer to prepare the Second Dilution (1:20).
4. Mix thoroughly and spin down to collect the liquid at the bottom of the tube.
5. Add 2 µL of this Second Dilution to the total RNA as indicated in Table 3.1.2.

**Note**

The First Dilution of the poly-A RNA controls can be stored up to six weeks in a non-frost-free freezer at -20°C and frozen-thawed up to eight times.
Step 2: cDNA Synthesis

1. Prepare the following mixture for primer annealing:

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total RNA</td>
<td>10 µg</td>
<td>0.33 µg/µL</td>
</tr>
<tr>
<td>75 ng/µL Random Primers</td>
<td>10 µL</td>
<td>25 ng/µL</td>
</tr>
<tr>
<td>Diluted poly-A RNA controls</td>
<td>2 µL</td>
<td>Variable</td>
</tr>
<tr>
<td>Nuclease-free H2O</td>
<td>Up to 30.0 µL</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td>30 µL</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The random primers supplied by Invitrogen Life Technologies are oligodeoxynucleotides composed mainly of hexamers. Random primers of different length or GC content have been successfully applied to the procedure.

2. Incubate the RNA/Primer mix at the following temperatures:
   - 70°C for 10 minutes
   - 25°C for 10 minutes
   - Chill to 4°C

3. Prepare the reaction mix for cDNA synthesis. Briefly centrifuge the reaction tube to collect sample at the bottom and add the cDNA synthesis mix from Table 3.1.3 to the RNA/primer hybridization mix.

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNA/Primer hybridization mix (from previous step)</td>
<td>30 µL</td>
<td></td>
</tr>
<tr>
<td>5X 1’st Strand Buffer</td>
<td>12 µL</td>
<td>1X</td>
</tr>
<tr>
<td>100 mM DTT</td>
<td>6 µL</td>
<td>10 mM</td>
</tr>
<tr>
<td>10 mM dNTPs</td>
<td>3 µL</td>
<td>0.5 mM</td>
</tr>
<tr>
<td>SUPERase•In (20 U/µL)</td>
<td>1.5 µL</td>
<td>0.5 U/µL</td>
</tr>
<tr>
<td>SuperScript II (200 U/µL)</td>
<td>7.5 µL</td>
<td>25 U/µL</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td>60 µL</td>
<td></td>
</tr>
</tbody>
</table>

4. Incubate the reaction at the following temperatures:
   - 25°C for 10 minutes
   - 37°C for 60 minutes
   - 42°C for 60 minutes
   - Inactivate SuperScript II at 70°C for 10 minutes
   - Chill to 4°C
Step 3: Removal of RNA

1. Add 20 µL of 1N NaOH and incubate at 65°C for 30 minutes.
2. Add 20 µL of 1N HCl to neutralize.

Step 4: Purification and Quantitation of cDNA

1. Use MinElute PCR Purification Columns to clean up the cDNA synthesis product (for detailed protocol, see MinElute PCR Purification Kit Protocols provided by the supplier). Elute the product with 12 µL of EB Buffer (supplied with the kit). The average volume of eluate is 11 µL from 12 µL of EB Buffer.
2. Quantify the purified cDNA product by 260 nm absorbance (1.0 A_{260} unit = 33 µg/mL of single-stranded DNA).

Note

Typical yields of cDNA are 3 to 7 µg. A minimum of 1.5 µg of cDNA is required for subsequent procedures to obtain sufficient material to hybridize onto the array and to perform necessary quality control experiments.
cDNA Fragmentation

1. Prepare the following reaction mix:

2. Incubate the reaction at 37°C for 10 minutes.

3. Inactivate DNase I at 98°C for 10 minutes.

4. The fragmented cDNA is applied directly to the terminal labeling reaction. Alternatively, the material can be stored at -20°C for later use.

Note: Use all remaining cDNA purified from the previous step in this reaction. Do not proceed if the yield is lower than 1.5 µg. Dilute DNase I to 0.6 U/µL in 1X One-Phor-All Buffer. Prepare fresh dilution each time immediately before use.

IMPORTANT: It is anticipated that DNase I enzyme activity may vary from lot to lot. A titration assay is strongly recommended for each new lot of enzyme to determine the dosage of the DNase I (unit of DNase I per µg of cDNA) to be used in the fragmentation reaction. 0.6U for each µg of cDNA can be used as a starting point for the titration.

To examine the fragmentation result, load ~200 ng of the product on a 4% to 20% acrylamide gel and stain with SYBR Gold. The majority of the fragmented cDNA should be in the 50 to 200 base-pairs range.

---

Table 3.1.4
Fragmentation Reaction

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>10X One-Phor-All Buffer</td>
<td>2 µL</td>
<td>1X</td>
</tr>
<tr>
<td>cDNA</td>
<td>10 µL</td>
<td>-</td>
</tr>
<tr>
<td>DNase I (see note below)</td>
<td>X µL</td>
<td>0.6 U/µg of cDNA</td>
</tr>
<tr>
<td>Nuclease-free H₂O</td>
<td>Up to 20 µL</td>
<td>-</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td>20 µL</td>
<td></td>
</tr>
</tbody>
</table>
Terminal Labeling

Use GeneChip® DNA Labeling Reagent (Affymetrix, P/N 900542) to label the 3' termini of the fragmentation products.

1. Prepare the following reaction mix:

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>5X Reaction Buffer</td>
<td>10 µL</td>
</tr>
<tr>
<td>GeneChip DNA Labeling Reagent, 7.5 mM</td>
<td>2 µL</td>
</tr>
<tr>
<td>Terminal Deoxynucleotidyl Transferase</td>
<td>2 µL</td>
</tr>
<tr>
<td>Fragmentation cDNA Product</td>
<td>Up to 20 µL</td>
</tr>
<tr>
<td>H₂O</td>
<td>16 µL</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>50 µL</strong></td>
</tr>
</tbody>
</table>

2. Incubate the reaction at 37°C for 60 minutes.

3. Stop the reaction by adding 2 µL of 0.5M EDTA.

4. The target is ready to be hybridized onto probe arrays, as described in Section 3, Chapter 2, *Prokaryotic Target Hybridization*. Alternatively, it may be stored at -20°C for later use.

To estimate the labeling efficiency, a gel-shift assay can be performed (see below). In general, greater than 90% of the fragments should be labeled and, therefore, shifted.

Gel-Shift Assay

The efficiency of the labeling procedure can be assessed using the following procedure. This quality control protocol prevents hybridizing poorly labeled target onto the probe array. The addition of biotin residues is monitored in a gel-shift assay, where the fragments are incubated with avidin prior to electrophoresis. The nucleic acids are then detected by staining, as shown in the gel photograph (Figure 3.1.2). The procedure takes approximately 90 minutes to complete.

**Note**

The absence of a shift pattern indicates poor biotin labeling. The problem should be addressed before proceeding to the hybridization step.
CHAPTER 1  Prokaryotic Target Preparation

1. Prepare a NeutrAvidin solution of 2 mg/mL in PBS.
2. Place a 4% to 20% TBE gel into the gel holder and load system with 1X TBE Buffer.
3. For each sample to be tested, remove two 150 to 200 ng aliquots of fragmented and biotinylated sample to fresh tubes.
4. Add 5 µL of 2 mg/mL NeutrAvidin to one of the two tubes for each sample tested.
5. Mix and incubate at room temperature for 5 minutes.
6. Add loading dye to all samples to a final concentration of 1X loading dye.
7. Prepare 10 bp and 100 bp DNA ladders (1 µL ladder +7 µL water+2 µL loading dye for each lane).
8. Carefully load samples and two ladders on gel. Each well can hold a maximum of 20 µL.
9. Run the gel at 150 volts until the front dye (red) almost reaches the bottom. The electrophoresis takes approximately 1 hour.
10. While the gel is running, prepare at least 100 mL of a 1X solution of SYBR Gold for staining.

**Note**  
SYBR Gold is light sensitive. Therefore, use caution and shield the staining solution from light. Prepare a new batch of stain at least once a week.

11. After the gel is complete, break open cartridge and stain the gel in 1X SYBR Gold for 10 minutes.
12. Place the gel on the UV light box and produce an image following standard procedure. Be sure to use the appropriate filter for SYBR Gold.
Prokaryotic Target Hybridization

Reagents and Materials Required .......................... 3.2.5
Reagent Preparation ........................................ 3.2.6
Prokaryotic Target Hybridization .......................... 3.2.7

This Chapter Contains:

This chapter contains detailed steps for preparing the hybridization mix, and instructions for hybridizing the target mix to the GeneChip® P. aeruginosa Genome Array and GeneChip® E. coli Antisense Genome Array. The hybridized probe array is then ready for washing, staining, and scanning as detailed in Section 3, Chapter 3.
Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and evaluated by Affymetrix scientists. Information and part numbers listed are based on U.S. catalog information. For supplier information, please refer to the Supplier Reference List in Appendix A of this manual.

- Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 51200
- Bovine Serum Albumin (BSA) solution, 50 mg/mL, Invitrogen Life Technologies, P/N 15561-020
- Herring Sperm DNA, Promega Corporation, P/N D1811
- Control Oligo B2, 3 nM, Affymetrix, P/N 900301 (can be ordered separately)
- NaCl, 5M, RNase-free, DNase-free, Ambion, P/N 9760G
- MES hydrate SigmaUltra, Sigma-Aldrich, P/N M5287
- MES Sodium Salt, Sigma-Aldrich, P/N M5057
- EDTA Disodium Salt, 0.5M solution (100 mL), Sigma-Aldrich, P/N E7889

Miscellaneous Reagents
- Tough-Spots, Label Dots, USA Scientific, P/N 9185 (optional)
- 100% DMSO, Sigma-Aldrich, P/N D2650
- Surfact-Amps 20 (Tween-20), 10%, Pierce Chemical, P/N 28320

Miscellaneous Supplies
- Hybridization Oven 640, Affymetrix, P/N 800138 (110V) or 800139 (220V)
- Sterile, RNase-free, microcentrifuge vials, 1.5 mL, USA Scientific, P/N 1415-2600 (or equivalent)
- Micropipetters, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)
- Sterile-barrier pipette tips and non-barrier pipette tips
Reagent Preparation

12X MES Stock Buffer

(1.22M MES, 0.89M [Na⁺])

For 1,000 mL:
- 64.61g of MES hydrate
- 193.3g of MES Sodium Salt
- 800 mL of Molecular Biology Grade water
Mix and adjust volume to 1,000 mL.
The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter.

![IMPORTANT]
Do not autoclave, store at 2°C to 8°C, and shield from light. Discard solution if yellow.

2X Hybridization Buffer (50 mL)

(Final 1X concentration is 100mM MES, 1M [Na⁺], 20 mM EDTA, 0.01% Tween-20)

For 50 mL:
- 8.3 mL of 12X MES Stock Buffer
- 17.7 mL of 5M NaCl
- 4.0 mL of 0.5M EDTA
- 0.1 mL of 10% Tween-20
- 19.9 mL of water
Store at 2°C to 8°C, and shield from light.
Prokaryotic Target Hybridization

After determining that the fragmented cDNA is labeled with biotin, prepare the hybridization solution mix. The minimum amount of cDNA product required for target hybridization is 1 µg. The solution is stable for approximately 6 to 8 hours at 4°C. The following protocol can be used for freshly prepared or frozen hybridization cocktail. Re-use of prokaryotic sample has not been thoroughly tested and, therefore, is not recommended.

1. Prepare the following hybridization solution mix.

<table>
<thead>
<tr>
<th>Components</th>
<th>169 Format (Mini)</th>
<th>100 Format (Midi)</th>
<th>49 Format (Standard)</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Hybridization Buffer</td>
<td>40 µL</td>
<td>65 µL</td>
<td>100 µL</td>
<td>1X</td>
</tr>
<tr>
<td>3 nM B2 Control Oligo</td>
<td>1.3 µL</td>
<td>2.2 µL</td>
<td>3.3 µL</td>
<td>50 pM</td>
</tr>
<tr>
<td>10 mg/mL Herring Sperm DNA</td>
<td>0.8 µL</td>
<td>1.3 µL</td>
<td>2.0 µL</td>
<td>0.1 mg/mL</td>
</tr>
<tr>
<td>50 mg/mL BSA</td>
<td>0.8 µL</td>
<td>1.3 µL</td>
<td>2.0 µL</td>
<td>0.5 mg/mL</td>
</tr>
<tr>
<td>100% DMSO</td>
<td>6.2 µL</td>
<td>10.2 µL</td>
<td>-</td>
<td>78% (or 0%)</td>
</tr>
<tr>
<td>Fragmented and Labeled cDNA</td>
<td>25 µL</td>
<td>Up to 50 µL</td>
<td>Up to 50 µL</td>
<td>0.5 – 7.0 µg</td>
</tr>
<tr>
<td>Molecular Biology Grade Water</td>
<td>5.9 µL</td>
<td>-</td>
<td>42.7 µL</td>
<td></td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>80 µL</strong></td>
<td><strong>130 µL</strong></td>
<td><strong>200 µL</strong></td>
<td></td>
</tr>
</tbody>
</table>

*Please refer to specific probe array package insert for information on array format.

2. Equilibrate probe array to room temperature immediately before use.

Note: It is important to allow the arrays to normalize to room temperature completely. Specifically, if the rubber septa are not equilibrated to room temperature, they may be prone to cracking, which leads to leaks.

3. Add the indicated amount of hybridization solution mix to the probe array. Refer to specific probe array package insert for information on array format.

Note: It is necessary to use two pipette tips when filling the probe array cartridge: one for filling and the second to allow venting of air from the hybridization chamber.

4. Place probe array in the hybridization oven set at the temperatures indicated below.
   - *P. aeruginosa* 50°C
   - *E. coli Antisense* 45°C

Note: The hybridization temperature of 50°C is higher than that used for other expression assays. The increased hybridization temperature is required due to the high GC content of *P. aeruginosa*.

5. Avoid stress to the motor; load probe arrays in a balanced configuration around axis. Rotate at 60 rpm.

6. Hybridize for 16 hours.

During the latter part of the 16-hour hybridization, proceed to Section 3, Chapter 3, *Prokaryotic Arrays: Washing, Staining, and Scanning* to prepare reagents required immediately after completion of hybridization.
Section 3, Chapter 3
Prokaryotic Arrays:
Washing, Staining, and Scanning

Reagents and Materials Required .................................................. 3.3.5
Reagent Preparation ........................................................................ 3.3.6
Experiment and Fluidics Station Setup ------------------------------- 3.3.8
  Step 1: Defining File Locations ..................................................... 3.3.8
  Step 2: Entering Experiment Information ...................................... 3.3.8
  Step 3: Preparing the Fluidics Station .......................................... 3.3.9
Probe Array Wash and Stain ............................................................. 3.3.10
Probe Array Scan ............................................................................ 3.3.17
  Handling the GeneChip® Probe Array .......................................... 3.3.17
  Scanning the Probe Array ............................................................ 3.3.18
Shutting Down the Fluidics Station ............................................... 3.3.19
Customizing the Protocol ............................................................... 3.3.20

This Chapter Contains:

- Instructions for using the Fluidics Station 400 or 450/250 to automate the washing and staining of GeneChip P. aeruginosa and GeneChip E. coli Antisense Genome Arrays.
- Instructions for scanning probe arrays using the GeneArray® Scanner or the GeneChip® Scanner 3000.

After completing the procedures described in this chapter, the scanned probe array image (.dat file) is ready for analysis, as explained in the enclosed GeneChip Expression Analysis: Data Analysis Fundamentals booklet (P/N 701190).
Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and evaluated by Affymetrix scientists. Information and part numbers listed are based on U.S. catalog information. For supplier information, please refer to the Supplier Reference List in Appendix A of this manual.

- Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 51200
- Nuclease-free Water, Ambion, P/N 9930
- Bovine Serum Albumin (BSA) solution, 50 mg/mL, Invitrogen Life Technologies, P/N 15561-020
- R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866
- NaCl, 5M, RNase-free, DNase-free, Ambion, P/N 9760G
- PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027
- 20X SSPE (3 M NaCl, 0.2M NaH₂PO₄, 0.02M EDTA), BioWhittaker Molecular Applications / Cambrex, P/N 51214
- Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I 5256
- Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500
- Surfact-Amps 20 (Tween-20), 10%, Pierce Chemical, P/N 28320
- Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 37001-060 (or equivalent)
- ImmunoPure Streptavidin, Pierce Chemical, P/N 21125

Miscellaneous Supplies

- Sterile, RNase-free, microcentrifuge vials, 1.5 mL, USA Scientific, P/N 1415-2600 (or equivalent)
- Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)
- Sterile-barrier pipette tips and non-barrier pipette tips
- Tygon Tubing, 0.04“ inner diameter, Cole-Parmer, P/N H-06418-04
- Tough-Spots, Label Dots, USA Scientific, P/N 9185-0000
Reagent Preparation

**Wash Buffer A: Non-Stringent Wash Buffer**

(6X SSPE, 0.01% Tween-20)

*For 1,000 mL:*

- 300 mL of 20X SSPE
- 1.0 mL of 10% Tween-20
- 699 mL of water
  
  Filter through a 0.2 µm filter.
  
  Store at room temperature.

**Wash Buffer B: Stringent Wash Buffer**

(100 mM MES, 0.1M [Na⁺], 0.01% Tween-20)

*For 1,000 mL:*

- 83.3 mL of 12 X MES Stock Buffer (see Section 3, Chapter 2 for reagent preparation)
- 5.2 mL of 5M NaCl
- 1.0 mL of 10% Tween-20
- 910.5 mL of water
  
  Filter through a 0.2 µm filter
  
  Store at 2°C to 8°C and shield from light.

**2X Stain Buffer**

(final 1X concentration: 100 mM MES, 1M [Na⁺], 0.05% Tween-20)

*For 250 mL:*

- 41.7 mL of 12X MES Stock Buffer (see Section 3, Chapter 2)
- 92.5 mL of 5M NaCl
- 2.5 mL of 10% Tween-20
- 113.3 mL of water
  
  Filter through a 0.2 µm filter.
  
  Store at 2°C to 8°C and shield from light.
10 mg/mL Goat IgG Stock

Resuspend 50 mg in 5 mL 150 mM NaCl.

Store at 4°C.

**Note**

*If a larger volume of the 10 mg/mL IgG stock is prepared, aliquot and store at -20°C until use. After the solution has been thawed it should be stored at 4°C. Avoid additional freezing and thawing.*

1 mg/mL Streptavidin Stock

Resuspend 5 mg in 5 mL of PBS.

Store at 4°C.
Experiment and Fluidics Station Setup

Step 1: Defining File Locations

Before working with Affymetrix® Microarray Suite it is important to define where the program stores and looks for files.

1. Launch Microarray Suite from the workstation and select **Tools → Defaults → File Locations** from the menu bar.

   The File Locations window displays the locations of the following files:
   - Probe Information (library files, mask files)
   - Fluidics Protocols (fluidics station scripts)
   - Experiment Data (.exp, .dat, .cel, and .chp files are all saved to location selected here)

2. Verify that all three file locations are set correctly and click **OK**.

   Contact Affymetrix Technical Support if you have any questions regarding this procedure.

For GeneChip® Operating Software (GCOS), this step is not necessary. Proceed directly to Step 2: Entering Experiment Information.

Step 2: Entering Experiment Information

To wash, stain, and scan a probe array, an experiment must first be registered in GCOS or Microarray Suite. Please follow the instructions detailed in the “Setting Up an Experiment” section of the appropriate GCOS or Microarray Suite User’s Guide.

The fields of information required for registering experiments in Microarray Suite are:

- Experiment Name
- Probe Array Type

In GCOS, three additional fields are required:

- Sample Name
- Sample Type
- Project

Sample templates, Experiment templates, and array barcodes can also be employed in GCOS to standardize and simplify the registration process. Please see the GCOS User’s Guide for more information.

The Project, Sample Name, and Experiment Name fields establish a sample hierarchy that organizes GeneChip gene expression data in GCOS. In terms of the organizational structure, the Project is at the top of the hierarchy, followed by Sample Name, and then Experiment Name.
CHAPTER 3  Prokaryotic Arrays: Washing, Staining, and Scanning

Step 3: Preparing the Fluidics Station

The Fluidics Station 400, or 450/250 is used to wash and stain the probe arrays. It is operated using GCOS/Microarray Suite.

Setting Up the Fluidics Station

1. Turn on the Fluidics Station using the switch on the lower left side of the machine.
2. Select Run → Fluidics from the menu bar.
   The Fluidics Station dialog box appears with a drop-down list for selecting the experiment name for each of the fluidics station modules. A second list is accessed for choosing the Protocol for each of the four fluidics station modules.

Note

Refer to the appropriate GeneChip® Fluidics Station User’s Guide for instructions on connecting and addressing multiple fluidics stations.

Priming the Fluidics Station

Priming ensures that the lines of the fluidics station are filled with the appropriate buffers and the fluidics station is ready for running fluidics station protocols.

Priming should be done:
- When the fluidics station is first started
- When wash solutions are changed
- Before washing if a shutdown has been performed
- If the LCD window instructs the user to prime

1. Select Protocol in the Fluidics Station dialog box.
2. Choose Prime or Prime_450 for the respective modules in the Protocol drop-down list.
3. Change the intake buffer reservoir A to Non-stringent Wash Buffer and intake buffer reservoir B to Stringent Wash Buffer.
4. For MAS, click Run for each module to begin priming. In GCOS, select the All Modules check box, then click Run.
Probe Array Wash and Stain

Following hybridization, the wash and stain procedures are carried out by the Fluidics Station. A modified FlexMidi_euk2v3 fluidics script (FlexMidi_euk2v3_450, if you are using the FS-450) is used for the GeneChip *P. aeruginosa* Genome Array, and the ProkGE-WS2 fluidics script (ProkGE-WS2_450, if you are using the FS-450) is used for the GeneChip *E. coli* Antisense Genome Array. The procedures take approximately 75 and 90 minutes, respectively, to complete. The use of streptavidin in the first part of the stain procedure enhances the overall signal.

After 16 hours of hybridization, remove the hybridization cocktail from the probe array and fill the probe array completely with the appropriate volume of Non-Stringent Wash Buffer (Wash Buffer A), as given in Table 3.3.1.

**Note**: If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours before proceeding with washing and staining. Equilibrate the probe array to room temperature before washing and staining.

### Table 3.3.1
Probe Array Cartridge Volumes

<table>
<thead>
<tr>
<th>Array</th>
<th>Hybridization Volume</th>
<th>Total Fill Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>49 Format (Standard)</td>
<td>200 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td>64 Format</td>
<td>200 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td>100 Format (Midi)</td>
<td>130 µL</td>
<td>160 µL</td>
</tr>
<tr>
<td>169 Format (Mini)</td>
<td>80 µL</td>
<td>100 µL</td>
</tr>
<tr>
<td>400 Format (Micro)</td>
<td>80 µL</td>
<td>100 µL</td>
</tr>
</tbody>
</table>

### Preparing the Staining Reagents

1. Prepare the following stain and wash solutions the day of the procedure. The solutions are stable for approximately 6 to 8 hours at 4°C. Volumes given are sufficient for one probe array.

   Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil wrapped or kept in an amber tube. Remove SAPE from the refrigerator and tap the tube to mix well before preparing stain solution.

   Do not freeze SAPE. Always prepare the SAPE stain solution fresh, on the day of use.

### Table 3.3.2
Streptavidin Solution Mix - Vial 1

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Stain Buffer</td>
<td>300.0 µL</td>
<td>1X</td>
</tr>
<tr>
<td>50 mg/mL BSA</td>
<td>24.0 µL</td>
<td>2 mg/mL</td>
</tr>
<tr>
<td>1 mg/mL Streptavidin</td>
<td>6.0 µL</td>
<td>10 µg/mL</td>
</tr>
<tr>
<td>Nuclease-free H₂O</td>
<td>270.0 µL</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>600 µL</strong></td>
<td></td>
</tr>
</tbody>
</table>
2. In the Fluidics Station dialog box on the workstation, select the correct experiment name from the drop-down **Experiment** list. The probe array type will appear automatically.

<table>
<thead>
<tr>
<th>Array</th>
<th>Fluidics Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneChip <em>E. coli</em> Genome 2.0 Array</td>
<td>Mini_prok2v1</td>
</tr>
<tr>
<td></td>
<td>(if using FS-450, Mini_prok2v1_450)</td>
</tr>
<tr>
<td>GeneChip <em>E. coli</em> Antisense Genome Array</td>
<td>ProkGE-WS2</td>
</tr>
<tr>
<td></td>
<td>(if using FS-450, ProkGE-WS2_450)</td>
</tr>
<tr>
<td>GeneChip <em>P. aeruginosa</em> Genome Array</td>
<td>Modified FlexMidi_euk2v3*</td>
</tr>
<tr>
<td></td>
<td>(*See Table 3.3.5. If using FS-450, FlexMidi_euk2v3_450)</td>
</tr>
</tbody>
</table>

**IMPORTANT** Fluidics protocols are specific to array format and content. Follow procedures below for specific arrays

3. Choose **Run** in the Fluidics Station dialog box to begin the washing and staining. Follow the instructions in the LCD window on the fluidics station when using the Fluidics Station 400.

   If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, please refer to the appropriate *User’s Guide* for your GeneChip® Fluidics Station 400, or 450/250.

---

**Table 3.3.3**
Antibody Solution Mix - Vial 2

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X MES Stain Buffer</td>
<td>300.0 µL</td>
<td>1X</td>
</tr>
<tr>
<td>50 mg/mL BSA</td>
<td>24.0 µL</td>
<td>2 mg/mL</td>
</tr>
<tr>
<td>10 mg/mL Normal Goat IgG</td>
<td>6.0 µL</td>
<td>0.1 mg/mL</td>
</tr>
<tr>
<td>0.5 mg/mL Anti-streptavidin Antibody, biotinylated</td>
<td>6.0 µL</td>
<td>5 µg/mL</td>
</tr>
<tr>
<td>Nuclease-free H₂O</td>
<td>264.0 µL</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>600 µL</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3.3.4**
SAPE Solution Mix - Vial 3

<table>
<thead>
<tr>
<th>Components</th>
<th>Volume</th>
<th>Final Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X MES Stain Buffer</td>
<td>300.0 µL</td>
<td>1X</td>
</tr>
<tr>
<td>50 mg/mL BSA</td>
<td>24.0 µL</td>
<td>2 mg/mL</td>
</tr>
<tr>
<td>1 mg/mL Streptavidin Phycoerythrin</td>
<td>6.0 µL</td>
<td>10 µg/mL</td>
</tr>
<tr>
<td>Nuclease-free H₂O</td>
<td>270.0 µL</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>600 µL</strong></td>
<td></td>
</tr>
</tbody>
</table>
GeneChip P. aeruginosa Genome Array requires a modification to the FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) protocol. See below for details.

The FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) fluidics protocol must be modified. Please follow the instructions carefully to make the modifications. Additionally, it is highly recommended that you save your new P. aeruginosa fluidics protocol under a different name to avoid confusion.

1. Modify and save the fluidics protocol for the assay:
   a. Modify the fluidics protocol by using Tools → Edit Protocol drop-down list and selecting FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) within the Protocol Name window.
   b. Change the following parameters: (Enter the new parameters by highlighting the default values and typing in the new values.)
      i) Wash A1 Temperature from 30°C to 25°C;
      ii) Number of Wash B Cycles from 6 to 4;
      iii) Stain Temperature (C) from 35°C to 25°C;
      iv) First Stain Time (seconds) from 300 to 600 seconds;
      v) Second Stain Time (seconds) from 300 to 600 seconds;
      vi) Third Stain Time (seconds) from 300 to 600 seconds; and
      vii) Wash A3 Temperature from 35°C to 30°C.
   c. Save the modified fluidics protocol by highlighting FlexMidi_euk2v3 (or the FlexMidi_euk2v3_450) within the Protocol Name window and typing over with an assigned protocol name (e.g., Pae_cDNA). Click Save.

The new fluidics protocol should be present in the Protocol drop-down list and is used in the subsequent steps.

2. Select the name of the newly modified protocol (e.g., Pae_cDNA) from the Protocol drop-down list in the Fluidics Station dialog box. Select Run in the Fluidics Station dialog box to begin the washing and staining. Follow the instructions in the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, please refer to the appropriate User’s Guide for your GeneChip® Fluidics Station 400, or 450/250.
### Table 3.3.6
Fluidics Scripts Prokaryotic Arrays

<table>
<thead>
<tr>
<th>Format</th>
<th>Fluidics Scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>169</td>
<td>Mini_prok2v1</td>
</tr>
<tr>
<td>100</td>
<td>modified FlexMidi_Euk2v3</td>
</tr>
<tr>
<td>49</td>
<td>ProkGE_WS2</td>
</tr>
</tbody>
</table>

When using the Fluidics Station 450 or 250 add \_450 at the end of the fluidics script’s name.

### Table 3.3.7
Fluidics Protocols

<table>
<thead>
<tr>
<th></th>
<th>Mini_prok2v1\textsuperscript{a}</th>
<th>FlexMidi\textsubscript{euk}2v3\textsuperscript{b}</th>
<th>Modified FlexMidi\textsubscript{euk}2v3 for \textit{P. aeruginosa} Array</th>
<th>ProkGE_WS2\textsuperscript{c}</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textbf{Post Hyb Wash #1}</td>
<td>10 cycles of 2 mixes/cycle with Wash Buffer A at 30°C</td>
<td>10 cycles of 2 mixes/cycle with Wash Buffer A at 30°C</td>
<td>10 cycles of 2 mixes/cycle with Wash Buffer A at 25°C</td>
<td>10 cycles of 2 mixes/cycle with Wash Buffer A at 25°C</td>
</tr>
<tr>
<td>\textbf{Post Hyb Wash #2}</td>
<td>4 cycles of 15 mixes/cycle with Wash Buffer B at 50°C</td>
<td>6 cycles of 15 mixes/cycle with Wash Buffer B at 50°C</td>
<td>4 cycles of 15 mixes/cycle with Wash Buffer B at 50°C</td>
<td>4 cycles of 15 mixes/cycle with Wash Buffer B at 45°C</td>
</tr>
<tr>
<td>\textbf{1\textsuperscript{st} Stain}</td>
<td>Stain the probe array for 300 seconds in Streptavidin Solution Mix at 35°C</td>
<td>Stain the probe array for 300 seconds in SAPE Solution Mix at 35°C</td>
<td>Stain the probe array for 600 seconds in Streptavidin Solution Mix at 25°C</td>
<td>Stain the probe array for 600 seconds in Streptavidin Solution Mix at 25°C</td>
</tr>
<tr>
<td>\textbf{2\textsuperscript{nd} Stain}</td>
<td>Stain the probe array for 300 seconds in Antibody Solution Mix at 35°C</td>
<td>Stain the probe array for 300 seconds in Antibody Solution Mix at 35°C</td>
<td>Stain the probe array for 600 seconds in Antibody Solution Mix at 25°C</td>
<td>Stain the probe array for 600 seconds in Antibody Solution Mix at 25°C</td>
</tr>
<tr>
<td>\textbf{3\textsuperscript{rd} Stain}</td>
<td>Stain the probe array for 300 seconds in SAPE Solution Mix at 35°C</td>
<td>Stain the probe array for 300 seconds in SAPE Solution Mix at 35°C</td>
<td>Stain the probe array for 600 seconds in SAPE Solution Mix at 25°C</td>
<td>Stain the probe array for 600 seconds in SAPE Solution Mix at 25°C</td>
</tr>
<tr>
<td>\textbf{Final Wash}</td>
<td>15 cycles of 4 mixes/cycle with Wash Buffer A at 35°C. The holding temperature is 25°C.</td>
<td>15 cycles of 4 mixes/cycle with Wash Buffer A at 35°C. The holding temperature is 25°C.</td>
<td>15 cycles of 4 mixes/cycle with Wash Buffer A at 30°C. The holding temperature is 25°C.</td>
<td>15 cycles of 4 mixes/cycle with Wash Buffer A at 30°C. The holding temperature is 25°C.</td>
</tr>
</tbody>
</table>

\textsuperscript{a} Mini_prok2v1\_450 for the FS-450/250
\textsuperscript{b} FlexMidi\_Euk2v3\_450 for the FS-480/250
\textsuperscript{c} ProkGE\_WS2\_450 for the FS-450/250
If you are using the Fluidics Station 450/250:

**Washing and Staining the Probe Array**

1. In the Fluidics Station dialog box on the workstation, select the correct experiment name from the drop-down **Experiment** list.
   ⇒ The **Probe Array Type** appears automatically.

2. In the **Protocol** drop-down list, select the appropriate antibody amplification protocol to control the washing and staining of the probe array format being used: Table 3.3.6.

3. Choose **Run** in the Fluidics Station dialog box to begin the washing and staining. Follow the instructions in the LCD window on the fluidics station.
   If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, please refer to the appropriate **Fluidics Station User’s Guide**, or **Quick Reference Card** (P/N 08-0093 for the FS-450/250 fluidics stations).

4. Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is down, or in the eject position. When finished, verify that the cartridge lever is returned to the up, or engaged, position.

5. Remove any microcentrifuge vial(s) remaining in the sample holder of the fluidics station module(s) being used.

6. If prompted to “Load Vials 1-2-3,” place the three experiment sample vials (the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station.
   a. Place one vial containing streptavidin solution in sample holder 1.
   b. Place one vial containing the anti-streptavidin biotinylated antibody solution in sample holder 2.
   c. Place one vial containing the streptavidin phycoerythrin (SAPE) solution in sample holder 3.
   d. Press down on the needle lever to snap needles into position and to start the run.
      ⇒ The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window display the status of the washing and staining as the protocol progresses.

7. When the protocol is complete, the LCD window displays the message **EJECT CARTRIDGE**.

8. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever to the eject position.

9. Lift up on the needle lever to disengage the needles from the microcentrifuge vials. Remove the three microcentrifuge vials from the needle holders.

10. Check the probe array window for large bubbles or air pockets.
   - If bubbles are present, refer to Table 3.3.8.
   - If the probe array has no large bubbles, it is ready to scan on the GeneArray® Scanner, or the GeneChip® Scanner 3000. Pull up on the cartridge lever to close the washblock and proceed to **Probe Array Scan** on page 3.3.17.
11. If there are no more samples to hybridize, shut down the fluidics station following the procedure in *Shutting Down the Fluidics Station* on page 3.3.19.

12. Keep the probe arrays at 4°C and in the dark until ready for scanning.

13. Lift up on the cartridge lever to close the washblock.

**Note**  
*For proper cleaning and maintenance of the fluids station, including the bleach protocol, refer to Section 4, Fluidics Station Maintenance Procedures.*

<table>
<thead>
<tr>
<th>Table 3.3.8</th>
</tr>
</thead>
<tbody>
<tr>
<td>If bubbles are present</td>
</tr>
</tbody>
</table>

Return the probe array to the probe array holder. Engage the washblock by gently pushing up on the cartridge lever to the engage position. The fluidics station will drain the probe array and then fill it with a fresh volume of the last wash buffer used. When it is finished, the LCD window will display **EJECT CARTRIDGE**. Again, remove the probe array and inspect it for bubbles. If no bubbles are present, it is ready to scan. Proceed to *Probe Array Scan* on page 3.3.17.

If several attempts to fill the probe array without bubbles are unsuccessful, the array should be filled with **Wash Buffer A (non-stringent buffer)** manually, using a micropipette. Excessive washing will result in a loss of signal intensity.

---

**If you are using the Fluidics Station 400:**

**Washing and Staining the Probe Array**

1. In the Fluidics Station dialog box on the workstation, select the correct experiment name in the drop-down **Experiment** list. The probe array type will appear automatically.

2. In the **Protocol** drop-down list, select the appropriate antibody amplification protocol to control the washing and staining of the probe array format being used: Table 3.3.6.

3. Choose **Run** in the Fluidics Station dialog box to begin the washing and staining. Follow the instructions on the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, please refer to the *Fluidics Station 400 User’s Guide, Fluidics Station 400 Video In-Service CD* (P/N 900374), or *Quick Reference Card* (P/N 08-0072).

4. Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is in the EJECT position. When finished, verify that the cartridge lever is returned to the ENGAGE position.

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station module(s) being used.

6. Place a microcentrifuge tube containing the streptavidin solution into the sample holder, making sure that the metal sampling needle is in the tube with its tip near the bottom

   ⇒ The Fluidics Station dialog box and the LCD window display the status of the washing and staining as they progress.

7. When the LCD window indicates, replace the microcentrifuge vial containing the streptavidin stain with a microcentrifuge vial containing antibody stain solution into the
sample holder, making sure that the metal sampling needle is in the vial with its tip near the bottom.

8. When the LCD window indicates, replace the microcentrifuge vial containing antibody solution with the microcentrifuge vial containing the streptavidin phycoerythrin (SAPE) solution.

9. When the protocol is complete, the LCD window displays the message **EJECT CARTRIDGE**.

10. Remove microcentrifuge vial containing stain and replace with an empty microcentrifuge tube.

11. Remove the probe arrays from the fluidics station modules by first moving the cartridge lever to the **EJECT** position.

12. Check the probe array window for large bubbles or air pockets.

   ▪ If bubbles are present, refer to Table 3.3.9.

   ▪ If the probe array has no large bubbles, it is ready to scan on the GeneChip Scanner 3000 or the GeneArray® Scanner. ENGAGE washblock and proceed to **Probe Array Scan** on page 3.3.17.

   If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for scanning.

   If there are no more samples to hybridize, shut down the fluidics station following the procedure outlined in the section, **Shutting Down the Fluidics Station**, on page 3.3.19.

   **Note**

   For proper cleaning and maintenance of the fluidics station, including the bleach protocol, refer to Section 4, **Fluidics Station Maintenance Procedures**.

   **Table 3.3.9**

   If bubbles are present

   Return the probe array to the probe array holder. Latch the probe array holder by gently pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the cartridge lever to the **ENGAGE** position.

   The fluidics station will drain the probe array and then fill it with a fresh volume of the last wash buffer used. When it is finished, the LCD window displays **EJECT CARTRIDGE** again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is ready to scan. Proceed to **Probe Array Scan** on page 3.3.17.

   If several attempts to fill the probe array without bubbles are unsuccessful, the array should be filled with **Wash Buffer A (non-stringent buffer)** manually, using a micropipette.

   Excessive washing will result in a loss of signal intensity.
Prokaryotic Arrays: Washing, Staining, and Scanning

3.3.17 Prokaryotic Probe Array Scan

The scanner is also controlled by Affymetrix Microarray Suite or GCOS. The probe array is scanned after the wash protocols are complete. Make sure the laser is warmed up prior to scanning by turning it on at least 15 minutes before use if you are using the Agilent GeneArray® Scanner, or 10 minutes if you are using the GeneChip® Scanner 3000. If the probe array was stored at 4°C, warm to room temperature before scanning. Refer to the Microarray Suite or GCOS online help and the appropriate scanner user’s manual for more information on scanning.

⚠️ WARNING The scanner uses a laser and is equipped with a safety interlock system. Defeating the interlock system may result in exposure to hazardous laser light.

✅ Note You must have read and be familiar with the operation of the scanner before attempting to scan a probe array. Please refer to the Microarray Suite User’s Guide (P/N 08-0081) or to the GeneChip® Scanner 3000 quick reference card (P/N 08-0075).

Handling the GeneChip® Probe Array

Before you scan the probe array, follow the directions in this section on handling the probe array. If necessary, clean the glass surface of the probe array with a non-abrasive towel or tissue before scanning. Do not use alcohol to clean glass.

Before scanning the probe array cartridge, follow this procedure to apply Tough-Spots™ to the probe array cartridge to prevent the leaking of fluids from the cartridge during scanning.

 водоем

🥗 IMPORTANT Apply the spots just before scanning. Do not use them in the hyb process.

1. On the back of the probe array cartridge, clean excess fluid from around septa.

2. Carefully apply one Tough-Spot to each of the two septa. Press to ensure that the spots remain flat. If the Tough-Spots do not apply smoothly; that is, if you observe bumps, bubbles, tears or curled edges, do not attempt to smooth out the spot. Remove the spot and apply a new spot. See Figure 3.3.1.
3. Insert the cartridge into the scanner and test the autofocus to ensure that the Tough-Spots do not interfere with the focus. If you observe a focus error message, remove the spot and apply a new spot. Ensure that the spots lie flat.

**Scanning the Probe Array**

1. Select Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in the tool bar.
   ⇒ The Scanner dialog box appears with a drop-down list of experiments that have not been run.

2. Select the experiment name that corresponds to the probe array to be scanned. A previously run experiment can also be selected by using the Include Scanned Experiments option box. After selecting this option, previously scanned experiments appear in the drop-down list.

3. By default, for the Agilent® GeneArray® Scanner only, after selecting the experiment the number [2] is displayed in the Number of Scans box to perform the recommended 2X image scan. For the GeneChip® Scanner 3000, only one scan is required.

4. Once the experiment has been selected, click the Start button.
   ⇒ A dialog box prompts you to load a sample into the scanner.

5. If you are using the GeneArray® Scanner, click the Options button to check for the correct pixel value and wavelength of the laser beam.
   - Pixel value = 3 µm
   - Wavelength = 570 nm
   If you are using the GeneChip Scanner 3000, pixel resolution and wavelength are preset and cannot be changed.
6. Open the sample door on the scanner and insert the probe array into the holder. Do not force the probe array into the holder. Close the sample door of the scanner. If you are using the GeneChip Scanner 3000, do not attempt to close the door by hand. The door closes automatically through the User Interface when start scan is selected or the scanner goes into stand-by mode.

7. Click OK in the Start Scanner dialog box.
   ⇒ The scanner begins scanning the probe array and acquiring data. When Scan in Progress is selected from the View menu, the probe array image appears on the screen as the scan progresses.

Shutting Down the Fluidics Station

1. After removing a probe array from the probe array holder, the LCD window displays the message ENGAGE WASHBLOCK.

2. If you are using the FS-400, latch the probe array holder by gently pushing up until a light click is heard. Engage the washblock by firmly pushing up on the cartridge lever to the ENGAGE position.
   If you are using the FS-450, gently lift up the cartridge lever to engage, or close, the washblock.
   ⇒ The fluidics station automatically performs a Cleanout procedure. The LCD window indicates the progress of the Cleanout procedure.

3. When the fluidics station LCD window indicates REMOVE VIALS, the Cleanout procedure is complete.

4. Remove the sample microcentrifuge vial(s) from the sample holder(s).

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with deionized water.

6. Select Shutdown or Shutdown_450 for all modules from the drop-down Protocol list in the Fluidics Station dialog box. Click the Run button for all modules.
   The Shutdown protocol is critical to instrument reliability. Refer to the appropriate Fluidics Station User’s Guide for more information.

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to the OFF position.

To maintain the cleanliness of the fluidics station and obtain the highest quality image and data possible, a weekly bleach protocol and a monthly decontamination protocol are highly recommended. Please refer to Section 4, Fluidics Station Maintenance Procedures for further detail.
Customizing the Protocol

There may be times when the fluidics protocols need to be modified. Modification of protocols must be done before downloading the protocol to the fluidics station. Protocol changes will not affect runs in progress. For more specific instructions, refer to the Microarray Suite/GCOS online help.

1. Select Tools → Edit Protocol from the menu bar.
2. In the Edit Protocol dialog box under Protocol Name, click the arrow to open a list of protocols. Click the protocol to be changed.
   ⇒ The name of the protocol is displayed in the Protocol Name text box. The conditions for that protocol are displayed on the right side of the Edit Protocol dialog box.
3. Select the items to be changed and input the new parameters as needed, keeping parameters within the ranges shown below in Table 3.3.10.

4. To return to the default values for the protocol selected, click the Defaults button.
5. Once all the protocol conditions are modified as desired, change the name of the edited protocol in the Protocol Name box.

   Table 3.3.10
   Valid Ranges for Wash/Stain Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Valid Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wash Temperature for A1, B, A2, or A3 (°C)</td>
<td>15 to 50</td>
</tr>
<tr>
<td>Number of Wash Cycles for A1, B, A2, or A3</td>
<td>0 to 99</td>
</tr>
<tr>
<td>Mixes / Wash Cycle for A1, B, A2, or A3</td>
<td>1 to 99</td>
</tr>
<tr>
<td>Stain Time (seconds)</td>
<td>0 to 86,399</td>
</tr>
<tr>
<td>Stain Temperature (°C)</td>
<td>15 to 50</td>
</tr>
<tr>
<td>Holding Temperature (°C)</td>
<td>15 to 50</td>
</tr>
</tbody>
</table>

- Wash A1 corresponds to Post Hyb Wash #1 in Table 3.3.7.
- Wash B corresponds to Post Hyb Wash #2 in Table 3.3.7.
- Wash A2 corresponds to Post Stain Wash in Table 3.3.7.
- Wash A3 corresponds to Final Wash in Table 3.3.7.

6. Click Save, then close the dialog box.

   Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, enter 0 (zero) for the stain time if staining is not required. Enter 0 (zero) for the number of wash cycles if a wash step is not required.

If the protocol is saved without entering a new Protocol Name, the original protocol parameters will be overwritten.